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SIMULAREA FUNCŢIONALĂ A CIRCUITELOR 
CU SIMULATORUL MODELSIM 

 
 
 
 
 

 În această lucrare se prezintă principiul simulatoarelor şi al simulării funcţionale asistate de 
calculator pentru circuite, iar apoi se prezintă un exemplu de simulare utilizând utilitarele puse la 
dispoziţie de sistemul de proiectare Xilinx ISE pentru simularea funcţională a circuitelor. Aceste 
utilitare sunt programul HDL Bencher, care permite crearea unor bancuri de test necesare pentru 
simulare, şi simulatorul ModelSim, care permite simularea circuitelor specificate prin scheme logice 
sau limbaje de descriere hardware. 

 1. Simularea asistată de calculator 

 1.1. Principiul simulării asistate de calculator 

 Simularea unui circuit permite verificarea funcţionării circuitului pe baza specificării acestuia 
prin oricare din metodele uzuale (limbaje de descriere hardware, scheme, diagrame de stare), înainte 
de implementarea efectivă a circuitului. Simularea asistată de calculator este metoda cea mai utilizată 
pentru simularea circuitelor, utilizarea acestei metode devenind posibilă şi pentru sistemele digitale 
complexe odată cu creşterea semnificativă a performanţei sistemelor de calcul moderne. Simularea se 
realizează cu ajutorul unui program simulator, care construieşte un model al circuitului pe baza 
descrierii acestuia de către proiectant, model care este echivalent cu o copie virtuală a circuitului 
proiectat. Simulatorul execută apoi modelul circuitului şi analizează răspunsul acestuia la o serie de 
combinaţii ale intrărilor aplicate circuitului într-un anumit interval de timp; o asemenea combinaţie 
este numită vector de test sau stimul. 
 Pe lângă vectorii de test, proiectantul poate specifica şi ieşirile aşteptate ale circuitului pentru 
fiecare vector. În acest caz, simulatorul va compara ieşirile generate prin execuţia modelului cu cele 
specificate de proiectant, care sunt cunoscute ca fiind corecte, afişând mesaje de eroare în cazul 
existenţei unor diferenţe între acestea. Dacă se detectează erori la simulare, descrierea circuitului 
poate fi corectată mult mai simplu decât în cazul în care circuitul a fost implementat. 
 Pentru simularea sistematică a funcţionării unui circuit, de multe ori se creează un banc de 

test (“testbench”), constând din circuitul care trebuie testat şi module adiţionale pentru generarea 
vectorilor de test şi aplicarea acestora la intrările circuitului. Vectorii de test pot fi reprezentaţi fie de 
toate combinaţiile posibile ale intrărilor circuitului (dacă este posibil), fie de combinaţiile 
reprezentative pentru toate situaţiile de funcţionare. Prin utilizarea bancurilor de test este posibilă 
simularea circuitului în condiţii reale, când acestuia i se aplică intrări din mediul exterior, de la un 
operator uman, sau de la un alt circuit sau sistem digital. 
 Simularea asistată de calculator are următoarele avantaje principale: 

• Simularea permite experimentarea cu diferite variante de proiectare şi condiţii de funcţionare 
ale circuitului, fără a fi necesară implementarea acestor variante. Proiectantul va putea 
implementa apoi varianta cea mai eficientă din punctul de vedere al performanţelor şi al 
costului. 

• Prin utilizarea simulării asistate de calculator este posibilă testarea sistematică a circuitelor 
prin aplicarea unui număr mare de vectori de test la intrările circuitului, vectori care pot fi 
generaţi prin program sau pot fi specificaţi sub formă tabelară. 
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• Pentru circuite sau sisteme digitale complexe, simularea asigură reducerea costurilor şi 
reducerea numărului erorilor de proiectare comparativ cu cazul în care se utilizează un 
prototip hardware pentru testare. Realizarea unor circuite complexe cum sunt 
microprocesoarele moderne nu ar fi fost posibilă fără utilizarea intensivă a simulării asistate 
de calculator. 

 1.2. Tipuri de simulare 

 Simularea poate fi executată în diferite etape ale procesului de proiectare şi poate utiliza 
diferite nivele de abstractizare ale circuitului specificat printr-o anumită metodă. 
 Simularea funcţională constă în simularea unei descrieri la nivel înalt a circuitului. Această 
descriere specifică funcţionarea circuitului, şi nu structura acestuia. Pentru descrierea circuitului se 
pot utiliza diferite limbaje de modelare, cum sunt limbajele de programare. În acest caz, simularea 
constă în compilarea şi execuţia modelului respectiv. În cele mai multe cazuri, simularea funcţională 
se bazează pe un model al circuitului sub forma unei descrieri într-un limbaj de descriere hardware 
(HDL). 
 Simularea logică reprezintă analiza funcţionării unui circuit pe baza valorii unor variabile 
logice. Această simulare este numită şi simulare la nivelul transferurilor între registre (RTL – 
Register Transfer Level), deoarece variabilele simulate sunt cele păstrate în registre. Simularea 
evaluează în fiecare ciclu de ceas funcţiile logice ale căror valori sunt înscrise în registre. 
 Simularea la nivel de circuite se referă la analiza funcţionării unor modele ale circuitelor 
reprezentate prin interconectarea unor dispozitive electronice cum sunt tranzistoare, rezistenţe şi 
condensatoare. Această simulare constă în calcularea nivelelor de tensiune în funcţie de timp din toate 
nodurile circuitului sau o parte a nodurilor. Aceasta presupune formularea şi rezolvarea unui mare 
număr de ecuaţii diferenţiale, necesităţile de memorie şi de timp de calcul fiind ridicate. 
 Simularea temporală constă în simularea funcţionării circuitului după determinarea întârzierii 
reale a semnalelor pe diferitele căi de date. Această simulare se utilizează în special pentru circuitele 
programabile, la care întârzierile semnalelor nu vor fi cunoscute decât în urma implementării 
circuitului, atunci când se poate determina numărul de conexiuni programabile utilizate pentru rutarea 
semnalelor. Informaţiile despre întârzierile semnalelor sunt furnizate simulatorului printr-o operaţie 
numită adnotare inversă. Simularea temporală permite analiza funcţionării în condiţii reale a 
circuitului şi determinarea frecvenţei maxime de funcţionare a acestuia. 

 1.3. Funcţionarea unui simulator 

 Un program de simulare necesită două tipuri de intrări: un fişier cu descrierea circuitului care 
trebuie simulat şi un set de stimuli care definesc toate semnalele de intrare pe durata timpului de 
simulare. Circuitul poate fi descris printr-o listă de conexiuni sau printr-un limbaj de descriere 
hardware. În cazul în care circuitul este specificat prin scheme sau diagrame de stare, trebuie creată 
mai întâi o descriere echivalentă a circuitului sub forma unei liste de conexiuni. Această descriere 
poate fi într-un format specific listelor de conexiuni (de exemplu, EDIF – Electronic Design 

Interchange Format), sau poate fi o descriere structurală a circuitului într-un limbaj de descriere 
hardware). 
 Proiectantul trebuie să specifice setul de stimuli care va fi aplicat la intrările circuitului pe 
durata simulării acestuia. Opţional, proiectantul poate specifica şi semnalele de ieşire care trebuie 
generate de circuit pentru fiecare stimul. Pentru definirea stimulilor, sistemele CAD sau simulatoarele 
pun la dispoziţie diferite interfeţe, cele mai utilizate fiind interfeţele grafice, interfeţele bazate pe 
fişiere text şi cele la nivelul liniei de comandă. Interfeţele grafice permit specificarea valorii 
semnalelor aplicate la intrările circuitului sub forma unor diagrame de timp. Aceste interfeţe sunt utile 
atunci când trebuie definit un număr redus de intrări. Atunci când există un număr mai mare de 
semnale de intrare, sau trebuie definit un număr mare de tranziţii ale acestor semnale, este mai utilă 
specificarea într-un fişier text a unor comenzi care definesc valorile semnalelor de intrare şi 
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momentele de timp în care semnalele îşi modifică valoarea. Pot exista şi comenzi care specifică 
execuţia simulării pentru un anumit timp. Introducerea comenzilor de simulare prin linia de comandă 
este utilă atunci când trebuie modificată valorile unor semnale care au fost definite anterior prin alte 
metode. 
 Simulatoarele utilizate în proiectarea asistată de calculator sunt simulatoare bazate pe 
evenimente. Aceste simulatoare împart intervalul de timp pentru care se realizează simularea în 
intervale de timp cu durate foarte reduse, un asemenea interval fiind numit pasul simulării. Acest pas 
este exprimat printr-un multiplu întreg al unei unităţi de timp care se numeşte limita de rezoluţie. 
Simulatorul nu poate măsura intervale de timp mai reduse decât această limită. Pentru simularea la 
nivel de porţi sau la nivel RTL, limita de rezoluţie poate fi, de exemplu, de 1 picosecundă (ps). După 
trecerea unui interval de timp egal cu pasul simulării, simulatorul determină toate semnalele ale căror 
valori au fost modificate pe durata ultimului pas al simulării, o asemenea modificare fiind numită 
eveniment. Pentru fiecare semnal de intrare care s-a modificat, simulatorul reevaluează modelul 
circuitului şi determină noile valori ale semnalelor care sunt afectate de această modificare. Această 
reevaluare determină modificarea altor semnale şi generarea altor evenimente. 
 Un semnal nu poate fi actualizat în acelaşi timp cu un alt semnal din care este generat, 
deoarece un semnal nu îşi pot modifica valoarea instantaneu. De aceea, modificarea valorii unui 
semnal este planificată de simulator pentru un moment de timp ulterior faţă de timpul curent de 
simulare (Tc), după o întârziere numită întârziere delta (δ). Deci, modificarea valorii semnalului va fi 
executată la momentul de timp Tc + δ. 
 La modificarea valorii unui semnal, se execută un ciclu delta în care se modifică valorile 
tuturor semnalelor care depind de primul semnal. Dacă semnalele modificate afectează alte semnale, 
vor fi planificate alte evenimente pentru timpul curent de simulare, la momentele de timp Tc + 2δ, Tc + 

3δ, ... La aceste momente vor fi executate alte cicluri delta pentru actualizarea valorii tuturor 
semnalelor. Toate aceste cicluri delta se execută pentru acelaşi moment de simulare (Tc), astfel încât 
timpul de simulare nu avansează decât atunci când nu mai sunt alte evenimente planificate pentru 
timpul curent de simulare şi toate semnalele au fost actualizate. Deci, întârzierea delta este de fapt o 
întârziere zero, doar în mod conceptual fiind considerată ca o întârziere infinitezimală, fiind introdusă 
pentru a indica succesiunea operaţiilor executate de simulator pentru actualizarea valorii semnalelor. 

 2. Exemplu de simulare 

 În această secţiune se prezintă etapele care trebuie executate pentru simularea funcţionării 
unui numărător simplu de 4 biţi, care numără în sens direct (de la 0000 la 1111). 

 2.1. Crearea fişierului sursă pentru numărător 

 Descrierea în limbajul VHDL a numărătorului este prezentată mai jos. Pentru actualizarea 
valorii numărătorului se utilizează o funcţie de incrementare a unui vector de biţi. 

library ieee; 
use ieee.std_logic_1164.all; 
 
entity num4 is 
   port (clk : in std_logic; 
         rst : in std_logic; 
         num : buffer std_logic_vector(3 downto 0)); 
end num4; 
 
architecture simul of num4 is 
 
   function inc_bv (a: std_logic_vector) return std_logic_vector is 
      variable r: std_logic_vector (a'range); 
      variable c: std_logic; 
   begin 
      c := '1'; 
      for i in a'range loop 
         r(i) := a(i) xor c; 
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         c    := a(i) and c; 
      end loop; 
      return r; 
   end inc_bv; 
 
begin 
   process (clk, rst) 
   begin 
      if (rst = '1') then 
         num <= (others => '0'); 
      elsif (clk'event and clk = '1') then 
         num <= inc_bv (num); 
      end if; 
   end process; 
end simul; 

 Creaţi un fişier text cu extensia .vhd (de exemplu, cu programul Notepad). Copiaţi descrierea 
VHDL a numărătorului în acest fişier, iar apoi salvaţi fişierul. 

 2.2. Crearea proiectului 

 Pentru crearea unui nou proiect, executaţi următoarele operaţii: 

1. Lansaţi în execuţie programul Project Navigator din cadrul sistemului de proiectare Xilinx 
ISE (Start → All Programs → Xilinx ISE 9.2i → Project Navigator). În ecranul acestui 
program, selectaţi comanda File → New Project. Va fi afişată fereastra de dialog Create New 

Project. În câmpul Project Location din această fereastră, selectaţi directorul în care se va 
crea proiectul (un subdirector din directorul D:\Student\). În câmpul Project Name 
introduceţi numele proiectului, de exemplu, labssc1_1. Selectaţi apoi butonul Next. 

2. În fereastra de dialog Device Properties, selectaţi tipul circuitului FPGA pentru care se 
creează proiectul. În câmpul Product Category selectaţi All. În câmpul Family selectaţi 
Spartan3, în câmpul Device selectaţi XC3S200, în câmpul Package selectaţi FT256, iar în 
câmpul Speed selectaţi –4. În câmpul Simulator selectaţi Modelsim-XE VHDL. Selectaţi 
apoi butonul Next. 

3. În fereastra de dialog Create New Source, selectaţi butonul Next. 

4. În fereastra de dialog Add Existing Sources, selectaţi butonul Next. 

5. În fereastra de dialog Project Summary, selectaţi butonul Finish pentru a crea proiectul. 

6. În ecranul Project Navigator, selectaţi comanda Project → Add Copy of Source pentru 
adăugarea la proiect a fişierului cu descrierea numărătorului. În fereastra Add Copies of 

Existing Sources selectaţi fişierul sursă creat anterior, după care selectaţi butonul Open. 

7. În fereastra de dialog Adding Source Files, păstraţi asocierea implicită pentru unităţile de 
proiectare, şi anume, Synthesis/Imp + Simulation. Selectaţi apoi butonul OK, prin care se va 
afişa un sumar al proiectului. 

 2.3. Compilarea fişierului sursă 

 Pentru compilarea fişierului sursă al numărătorului, executaţi următoarele operaţii: 

1. În fereastra Sources for din partea stânga sus a ecranului Project Navigator, selectaţi opţiunea 
Synthesis/Implementation pentru afişarea proceselor corespunzătoare etapelor de sinteză şi 
implementare. Procesele afişate vor permite şi compilarea fişierului sursă. 

2. În fereastra Sources for, executaţi un clic dublu pe numele fişierului sursă pentru afişarea 
conţinutului acestui fişier în fereastra de editare. 
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3. În fereastra Processes, expandaţi lista proceselor de sinteză (Synthesize – XST) şi executaţi un 
clic dublu pe procesul Check Syntax pentru compilarea fişierului sursă. În cazul în care sunt 
erori de compilare, corectaţi aceste erori şi recompilaţi fişierul. 

 2.4. Crearea unui fişier pentru bancul de test 

 Pentru crearea unui fişier care va conţine vectorii de test, fişier care va fi utilizat apoi pentru 
crearea unui banc de test, procedaţi astfel: 

1. În ecranul Project Navigator, selectaţi comanda Project → New Source pentru crearea unui 
nou fişier. În fereastra de dialog Select Source Type, selectaţi Test Bench WaveForm ca tip al 
noului fişier. În câmpul File Name introduceţi numele fişierului care va fi creat. Acest nume 
trebuie să fie diferit de numele fişierului sursă VHDL. De exemplu, dacă numele fişierului 
sursă este num, numele fişierului pentru bancul de test poate fi num_tb. Selectaţi apoi 
butonul Next. 

2. În fereastra de dialog Associate Source, păstraţi asocierea implicită cu entitatea numărătorului 
(num4), iar apoi selectaţi butonul Next. 

3. În fereastra de dialog Summary, selectaţi butonul Finish. Prin aceste operaţii, se va lansa în 
execuţie programul HDL Bencher şi se va afişa fereastra Initialize Timing. 

4. În fereastra Initialize Timing, se pot seta parametrii de timp ai semnalului de ceas, ai 
semnalelor de intrare şi ai celor de ieşire. Pentru aceşti parametri, păstraţi valorile implicite. 
Aceste valori sunt ilustrate în Figura 1. Deselectaţi opţiunea GSR (FPGA) din zona Global 

Signals. Selectaţi apoi butonul Finish, prin care se va afişa fereastra programului HDL 

Bencher, conţinând semnalele de intrare şi de ieşire ale numărătorului. Semnalul de ceas clk 
este iniţializat în mod automat conform parametrilor care au fost setaţi în fereastra Initialize 

Timing. 

 

Figura 1. Fereastra Initialize Timing a programului HDL Bencher. 
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5. Pentru iniţializarea semnalului rst, setaţi acest semnal la valoarea 1 la timpul de simulare 0 ns, 
iar apoi setaţi semnalul la valoarea 0 la timpul de simulare 100 ns. Pentru aceasta, executaţi 
un clic în zona albă din stânga primei celule albastre din linia semnalului rst, iar apoi 
executaţi un clic în interiorul primei celule albastre (cea corespunzătoare timpului de simulare 
de 100 ns). 

6. Setaţi timpul de sfârşit al bancului de test la 3200 ns. Pentru aceasta, selectaţi comanda Test 

Bench → Set End of Test Bench, prin care se va afişa caseta de dialog Set End of Test Bench. 
În câmpul Test Bench Ends introduceţi valoarea 3200, după care selectaţi butonul OK. În acest 
moment, fereastra HDL Bencher arată ca în Figura 2. 

 

Figura 2. Fereastra HDL Bencher cu formele de undă ale semnalelor de intrare. 

7. Salvaţi fişierul cu bancul de test prin comanda File → Save sau cu butonul Save . 

8. Închideţi fereastra programului HDL Bencher. 

 2.5. Simularea funcţională 

 Pentru simularea funcţională a numărătorului, procedaţi astfel: 

1. În fereastra Sources for din ecranul Project Navigator, selectaţi opţiunea Behavioral 

Simulation pentru afişarea proceselor corespunzătoare etapei de simulare funcţională. 

2. În aceeaşi fereastră, selectaţi fişierul cu extensia .tbw care a fost creat anterior cu programul 
HDL Bencher. 

3. În fereastra Processes, executaţi un clic pe semnul + din stânga liniei ModelSim Simulator 
pentru afişarea proceselor disponibile. 

4. Executaţi un clic dublu pe linia Simulate Behavioral Model. Prin aceasta, programul Project 

Navigator va crea un fişier de comenzi cu extensia .fdo, conţinând comenzile care trebuie 
executate de simulatorul ModelSim, după care va lansa în execuţie simulatorul. Acesta va 
executa simularea utilizând vectorii de test specificaţi în bancul de test, iar apoi va afişa 
rezultatele simulării în fereastra cu forma de undă a semnalelor (Wave). Simulatorul va 
deschide de asemenea fereastra spaţiului de lucru (Workspace) şi fereastra semnalelor 
(Objects). 

5. Maximizaţi fereastra Wave prin execuţia unui clic pe butonul + al acestei ferestre. 

6. În fereastra Wave, executaţi un clic pe butonul Zoom Full  pentru vizualizarea formei de 
undă complete a semnalelor. 

7. În aceeaşi fereastră, observaţi că secvenţa de numărare obţinută, indicată prin succesiunea 
valorilor binare ale semnalului num, este 0, 8, 4, 12, 2, ..., secvenţă care nu este corectă 
(Figura 3). Se mai poate observa că valorile binare ale vectorului num corespund secvenţei 
corecte de numărare în cazul în care biţii sunt citiţi începând cu cel mai puţin semnificativ (în 
ordine inversă). 

8. Încheiaţi sesiunea de simulare prin închiderea ferestrei principale a simulatorului sau prin 
execuţia comenzii File → Quit. 

DAN
Stamp



Structura sistemelor de calcul – Simularea funcţională a circuitelor cu simulatorul ModelSim 7 

 

Figura 3. Afişarea rezultatelor simulării în fereastra Wave a simulatorului ModelSim. 

 2.6. Corectarea erorii 

 Pentru corectarea descrierii numărătorului, reveniţi în ecranul Project Navigator şi deschideţi 
pentru editare fişierul sursă VHDL. Se poate observa că în funcţia inc_bv vectorul de biţi transmis 
ca parametru este prelucrat în ordinea corespunzătoare domeniului vectorului (a'range). Pentru 
incrementarea corectă a vectorului, bucla for .. loop trebuie parcursă începând cu bitul cel mai puţin 
semnificativ al vectorului. Deci, eroarea se poate corecta prin modificarea următoarei linii sursă 

      for i in a'range loop 

astfel: 

      for i in a'low to a'high loop 

 Corectaţi fişierul sursă şi salvaţi fişierul prin comanda File → Save sau cu butonul Save . 

 2.7. Reexecutarea simulării funcţionale 

 Pentru reexecutarea simulării funcţionale a numărătorului, executaţi următoarele operaţii: 

1. Compilaţi din nou fişierul sursă în modul descris în secţiunea 2.3 şi corectaţi eventualele 
erori. 

2. În fereastra Sources for din ecranul Project Navigator, selectaţi opţiunea Behavioral 

Simulation. 

3. Lansaţi în execuţie simulatorul ModelSim executând un clic dublu pe linia Simulate 

Behavioral Model din fereastra Processes. 

4. Maximizaţi fereastra Wave a simulatorului, iar apoi executaţi un clic pe butonul Zoom Full 

. 

5. Selectaţi semnalul num. Executaţi un clic cu butonul din dreapta pe acest semnal şi selectaţi 
opţiunea Radix, iar apoi opţiunea Hexadecimal. 

6. Se poate observa că secvenţa de numărare este acum cea corectă. 

7. Închideţi fereastra principală a simulatorului ModelSim. 

 3. Aplicaţii 

 3.1. Răspundeţi la următoarele întrebări: 

a. Ce este un vector de test şi cum se poate reprezenta acesta? 

b. Care sunt avantajele simulării asistate de calculator? 

c. Care sunt principalele tipuri de simulare? 

d. Ce intrări sunt necesare pentru un simulator şi ce metode pot fi utilizate pentru 
specificarea acestor intrări? 

DAN
Stamp

DAN
Stamp


	1. Simularea asistată de calculator
	1.1. Principiul simulării asistate de calculator
	1.2. Tipuri de simulare
	1.3. Funcţionarea unui simulator

	2. Exemplu de simulare
	2.1. Crearea fişierului sursă pentru numărător
	2.2. Crearea proiectului
	2.3. Compilarea fişierului sursă
	2.4. Crearea unui fişier pentru bancul de test
	2.5. Simularea funcţională
	2.6. Corectarea erorii
	2.7. Reexecutarea simulării funcţionale

	3. Aplicaţii



